
 PACKING. YOU KEEP TO MECHANICALS & CARRIERSCUPS,WE   SIZERS, MANUFACTURE 



 

 



 

 

TrueSort User’s Manual    January 2012 

 
2 

 

Startup/Shutdown Procedure .............................................................................................................. 3 

Startup: ............................................................................................................................................ 3 

Shutdown: ....................................................................................................................................... 3 

Getting Started .................................................................................................................................... 5 

The Main Screen .............................................................................................................................. 5 

Start To Grade ...................................................................................................................................... 6 

Grading Programs ................................................................................................................................ 7 

Working With The Grading Program ................................................................................................. 8 

Distribution & Packaging .................................................................................................................... 11 

Distribution .................................................................................................................................... 11 

Statistics ............................................................................................................................................ 15 

Program statistics ........................................................................................................................... 15 

Machine Statistics .......................................................................................................................... 20 

User Levels ......................................................................................................................................... 21 

Splitting Lanes .................................................................................................................................... 24 

Measurement Results ........................................................................................................................ 26 

Textual results ................................................................................................................................ 26 

Image results.................................................................................................................................. 27 

Backup/Restore Your Data ................................................................................................................. 29 

Backup Procedure .......................................................................................................................... 29 

Restore Procedure ......................................................................................................................... 31 

System Maintenance.......................................................................................................................... 35 

Troubleshooting ................................................................................................................................. 36 

Getting Support ................................................................................................................................. 39 

 

  



 

 

TrueSort User’s Manual    January 2012 

 
3 

Startup/Shutdown Procedure 

The Ellips system consists of two or more computers. One computer runs Windows with the user-

interface application. If your system can only grade on weight, it is quite likely that the second computer 

is a MiniMaster. All other systems have one or more 19” rack master computers. Ellips computers should 

not be connected directly to the main power lines. Instead an online UPS (uninterruptible power supply) 

must be inbetween the power lines and the computers. The UPS is a big battery that protects the 

computers from spikes and voltage drops on the power lines. See connection diagrams below.  

Startup: 

Locate the UPS and switch it on. If you cannot locate the UPS, please contact your machine supplier (in 

some cases the UPS is remotely activated from a main panel). Some UPS models require you to hold the 

power button for a few seconds before they switch on. When the UPS is powered up, the master 

computer(s) and Profibus boards will also power up. Now you can power up the user-interface computer 

by pressing the power button on the front. On the monitor you will see Windows booting and after that 

automatically the TrueSort interface application will start. Once the TrueSort application is up and 

running, look for the system status. It is either located on the right in a post-it or on the top toolbar. A 

green check sign indicates the system is ready to use. If you see a red cross, be patient for a few minutes 

as the system is probably still initializing.  

 

Shutdown: 

Shutdown Windows first, either by pressing the power button on the front of the user-interface 

computer or from the Windows 'Start' menu. Wait for Windows to shut down completely, the computer 

will power off automatically. Now power off the UPS. Again you might need to hold the UPS power 

button for a few seconds to initiate the shutdown. Master computer and Profibus boards should now be 

off as well.  
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Diagram for a weight only system: 

 

 

Diagram for all other systems: 
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Getting Started 

Before we can actually start grading we have to be familiar with the TrueSort main screen.  

The Main Screen 

 

A major part of the main screen can be customized to your preference. Actually only the top toolbar and 

the active program bar are fixed. The 'post-it' area on the right can be switched off completely (the 

system status icon will automatically move to the top toolbar). The dashboard below can be replaced 

with a slim status bar. These customizations help to increase the working area if required. Different 

layout schemes can be chosen for the working area. Depending on the layout you choose, one or more 

panes are shown in the working area. As a user you decide what information you like to attach to a pane. 

For instance: grading criteria, statistics, packaging & distribution, measurement results etc.  

To add/remove the post-its or replace the dashboard with the status bar, click on the TrueSort logo in 

the top left corner of your screen. A menu will pop up. Now choose Edit→Settings and select the GUI 

Properties tab to make the desired changes. It may seem like you are able to modify the Maximum Cup 

Speed here as well but this value is only used for the range of the speed indicator located in the bottom 

left of the big dashboard.  

To choose a different layout for the panes, click on the TrueSort logo and from the popup menu select 

Window→Layout.  
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Click on the small triangle in the top right of a pane to attach the desired content/information for that 

pane. 

 

Start To Grade 

A few crucial things need to be checked before starting. First and foremost is the system status. A green 

check sign indicates the system is ready to grade. If the system status shows a red cross with an error 

message, the system will not function correctly. Check the troubleshooting page if the status remains 

'Error'.  

Next thing to check is the active grading program. If it's not the program you wanted, select a different 

one from the list. The statistics will reset automatically. If there is no need to change the program but 

you would like to reset the statistics, click on the Statistics icon from the toolbar and press the Reset 

button in the statistics window.  

Now would be a good time to start the machine empty (without produce). In the bottom left corner of 

the screen the speed of the machine is displayed. If your system measures the weight of each fruit 

individually, it is best to reset the tare cup/roller weight (Tare Cups from the toolbar) at this point. The 

system will show a message that will automatically disappear when the tare is done. Depending on how 

important the accuracy of the weight is to you and how recently you have switched on the electronics 

we recommend to run the machine empty for about five to ten minutes before actually starting. That will 

give the electronics some time to go to a stable temperature resulting in a more stable weight 

measurement.  

Start to grade!  
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Grading Programs 

A grading program holds all information needed by the system for detecting, measuring, classifying, 

distributing and packing the produce. An unlimited amount of grading programs may be created.  

Click on the Programs toolbar button to open the Maintain Grading Programs window.  

 

 

 

The Maintain Grading Programs window shows the list of programs currently available. Here you may 

add, delete, rename, copy, open or activate a program. To save time and trouble we recommend to copy 

a similar program instead of adding a new one.  

Opening the active grading program and/or activating a program is more easy directly from the main 

screen (active program bar).  

There are two ways to protect grading programs. Especially when multiple users control the system you 

may feel the need to protect a program from being modified by somebody else. Please refer to the 

document Protecting Programs (if it is unavailable to you please contact your dealer).  
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Working With The Grading Program 

Only the active grading program can be docked into the working area. Activating a different program will 

automatically open and replace the currently docked grading program window. In other words, the 

docked grading program window always shows the active grading program. Other programs may be 

edited simultaneously and they will be shown as a popup window. Pressing Apply in the grading program 

window will save your modifications. If it is the active program, the changes will be effected immediately 

to the current grading process. Press Reset to go back to the last applied state.  

 

The classification of the product works from top to bottom only; the left to right order is of no 

consequence. Once all the measured results for a product are known, the classification process starts to 

check the first row in the grading program. If it meets the criteria of that row, the product belongs to 

that class. If not, the second row in the program is checked and so forth until it meets all the 
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requirements in a row. If it does not meet the criteria of any of the rows, the product is unclassified and 

it will go to the end of the machine.  

In the Class Name column, an arbitrary name may be chosen for a class. In the same row the Exit column 

shows the exits belonging to this class. In-between, the measurement columns hold the criteria for 

unique classification. Measurement columns may be added and removed as needed, keeping the grading 

program as simple as possible. Click on the Settings →Columns button in the bottom left corner to 

activate or deactivate columns in the grading program. Measurement columns always have a minimum 

and maximum value.  

Only active columns are used to grade a product.  

If a criterium cell is empty, it is considered a 'wildcard'. The use of wildcards is very handy. Take a look at 

the example above. The first row shows no criteria except for the Defect column. Meaning that no 

matter the diameter, color or brix result, if it has a more than 0.5% defect on it (with respect to the total 

surface), it should go to exit 1. The second row does the same for brix and so products with a brix value 

higher than 4.5 are sent to exit 1 as well. So if the defect measurement result is higher than 0.5% and/or 

the brix measurement result is higher than 4.5 the product will be classified as 'Defect' and sent to exit 

one. If these two rows were combined in one row, it would read: if the defect measurement is higher 

than 0.5% and the brix measurement result is higher than 4.5 etc. and so the outcome would be 

different. Take a look at row 5, products with a diameter between 50 and 60mm and a blush percentage 

higher than 50% will go to exit 4. The same sized products but with less blush will go to exit 12.  

Click on the small triangle next to the row number to insert or remove a row.  

Sometimes you may want to change a value that occurs multiple times in the same measurement 

column. Right click on the header of the column (diameter in this example) to open the following 

window:  
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Now modify the desired value and press OK. All cells containing the old value will be replaced with the 

new value. More easy and less chance of mistakes!  

Some measure method columns offer additional settings to fine tune the behaviour of the 

measurement. Click on the small black triangle next to the header and choose Edit measure method to 

make changes. Please refer to the Sort/Variety section to get detailed information about these additional 

settings.  

 

 

Buttons not discussed:  

Some options available from the grading program (buttons at the bottom) window have not been 

discussed here. Please refer to the chapters on these subjects:  

• Settings →Sort/Variety Settings (option maybe not visible due to user level) 

• Settings →Background separation 

• Settings →Split lanes (option maybe not visible due to user level) 

• Distribution, see Distribution & Packaging 

• Histograms 
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Distribution & Packaging 

Distribution 

After classification the produce is sent to an exit of choice that was previously set in the grading 

program. If there is only one exit for the class and the exit is just a container that can buffer the received 

produce, your possibilities are very limited. However, in many cases you may want to control how the 

flow of produce is going to the exits. Open the distribution (and packaging) dialog from the grading 

program dialog. Click on the Distribution button and the following dialog will show:  

 

A distribution fill mode should be set for every class in the grading program, although it only makes 

sense if multiple exits are assigned to a class. Here are the most common examples:  

Distribution Fill Modes 

Uniform - Produce will be divided equally to all exits of the class. 

Percentage - A different percentage of a class may be sent to each exit of the class (see example above). 
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Exit Sequence - The first exit will fill to the set package amount and/or weight and then the next exit of 

the class will start to fill etc. until the last package of the class is filled. Then it will start all over again. 

Accurate Weight - License needed. Will fill a package accurately to the desired weight with minimum 

overweight. This distribution algorithm needs at least three exits for the same class to function properly. 

More exits will improve performance. 

Dynamic Exits - License needed. Will claim a free exit for a certain class and release it when the package 

is finished or when another class has priority. Especially useful when there are a limited amount of exits 

and the deviation of the incoming produce is unknown. 

The distribution will always drop the produce on an exit. Consider a class with three exits assigned that 

have just finished their packages. The system will block the exits for new produce to prevent package 

errors. However since these are the only three exits for the class the new arriving produce must be 

dropped onto one of these exits. The system will wait as long as possible hoping one of the exits will be 

ready for new produce again. If that does not happen, the last exit of the class will be chosen to drop the 

produce resulting in an error for the current package. A lamp may be mounted at every exit to indicate 

the package errors. To avoid this behavior an alternative exit may be set to give the system the 

opportunity to send produce to this exit when all exits for a certain class are blocked.  

Packaging 

If the TrueSort system is in control of the packages the following dialog must be configured to get the 

desired results.  
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In the example above exit 2 will make packages of 50 pieces of produce. Class 'Undersize' will deliver 40 

pieces in every package and the rest (10 pieces) will be added with class '90+'. This is actually a bad 

example as there is no alternative exit for these classes. If the system would receive 50 pieces of 

'Undersize' and less than 10 pieces of '90+', the package would close in error state. Multiple exits with 

the same class will solve this problem as well as setting an alternative exit.  

Exit 7, 8 and 9 have the same class assigned and so the produce will be divided between these exits. The 

distribution setting determines how it will be divided. In this example the produce of this class is sent to 

all three exits at the same time but exit 7 will receive less than exit 8 and exit 8 will receive less than exit 

9. If one of these exits is blocked because the package is finished, the other two exits will receive all the 

produce of the class again divided according to their percentages. Once the blocked exit is free again it 

will catch-up and receive more produce than normal for a short while.  

Instead of using distribution mode Percentage, exit 7, 8 and 9 could have also been configured for Exit 

sequence. Packages would then be finished one by one. So exit 7 would receive all the produce of the 

class until the package is finished. The produce will then be sent to exit 8 until that package is finished, 

then it would go to exit 9 etc.  
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Common packages may be predefined and then selected using the Package column on the right. To add 

predefined packages to the system click on the TrueSort logo at the top left of your screen and choose 

Edit →Packages from the popup menu.  

When a package is finished, people operating the machine or automatic packers may need to be 

signaled. Refer to the Exit Control settings to see if the required signaling is configured. 
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Statistics 

During the grading process statistics are collected for every class and exit. Statistical information is 

updated every five seconds by the master computer. Even if the Windows user-interface computer 

needs rebooting the statistics information is not lost. The master computer still collects the data and as 

soon as the Windows computer is back online the statistics are updated again. Statistics are reset 

automatically when activating a different grading program. In fact the current statistics file is closed and 

a new file is created. The same applies for resetting the statistics manually (Reset Batch button). So you 

never need to worry about losing statistical information.  

Click on the Statistics button from the main toolbar.  

Program statistics 

At the top there are three tabs. The first tab, Grading Program,shows the statistical information per 

class or per exit for the current grading program. The second tab, Statistics Program, may be disabled 

unless you are running a second grading program simultaneously merely for collecting different 

statistical information for the same batch (see Double Statistics).  

 



 

 

TrueSort User’s Manual    January 2012 

 
16 

The tabs at the bottom let you decide whether you would like to view the statistical information based 

on classes or on exits. The image above shows the class statistics. The image below shows the per exit 

statistics.  

 

The Grading Program tab shows a number of buttons:  

• Columns 

• Properties 

• Print 

• Flush Exits 

• Reset Batch 

These five buttons are described below.  

Columns 

Depending on your system setup you may not be interested in all the columns you see in the statistics 

table or maybe you miss some data. Click on the Columns button and select the columns that interest 

you.  
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Properties 

Maybe you would like to store some additional data to your current statistics batch. Click on the 

Properties button to open the Statistics Batch Properties dialog. Here you are able to modify the batch 

label, grower name, field properties etc.  
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Print 

Clicking on the Print button opens the Print Preview dialog. Only the active columns (set via the Columns 

button) in the statistics view are printed. Optionally the grading program and exits view may be printed 

as well. If no printer is present the statistics may also be printed to a PDF file for later reference.  
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Flush Exits 

The Flush Exits button removes the produce from all exits and resets the package weights and amounts. 

If packages are manually removed, they will need to be removed from the machine before pressing the 

Flush Exits buttons.  

Reset Batch 

Resets the batch. In fact a new statistics file is created. If no batch label is entered, the statistics 

properties dialog will open to let you enter it.  

Exits will not be flushed/reset!  

  



 

 

TrueSort User’s Manual    January 2012 

 
20 

Machine Statistics 

The third tab at the top, Machine Statistics, shows the load on the machine in a graph. It shows how 

many hours of the day the machine has actually been grading and how high the load was at a particular 

time. It also shows the possible load differences between the lanes.  
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User Levels 

By default, the TrueSort Gui starts up with the user Guest. In most cases the Guest has restricted 

access to features available in the TrueSort application. Log in as Maintenance to get full access 

by pressing F1 or click on the TrueSort logo and choose File →Switch User from the main menu.  

 

If you are logged in in the TrueSort Gui as the user Maintenance, you can manage the rights of 

other users of the TrueSort Gui. Click on the TrueSort logo and choose File →User Management.  
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• You cannot delete the currently logged on user. 

• You cannot delete the Maintenance and Guest users, as they are built-in.  

In the maintenance level you are entitled to create new users with their own rights or change 

permissions for any user account.  

Please do yourself a favor and do not give the Guest account Read/Write access to the User 

Administration and Grading program folders administration operations.  
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Available operations  

Operation  Description  

Current grading settings  

Activate a grading program.  

None: you cannot change the active grading program.  

Read/Write: you can activate another grading program.  

Open Grading Table  

Modify a grading/statistics program.  

None/Read: Inspect a program, but not modify it (the Apply button is 

disabled).  

Read/Write: Make changes to a program.  

Sort Variety  Change the settings of the sorting algorithms.  

User Administration  Manage user accounts and access rights.  

System Configuration  Modify the system configuration.  

Dropout Configuration  
 

Weight Configuration  
 

Misc. Advanced/Dealer  
 

Camera Equalizer 

Advanced Mode   

Add/Remove extra 

weight measure methods  

Add/Remove the measure methods Empty cup weight, Reference 

weight and Raw weight.  

These measure methods should only be activated in a program when 

you want to find some problems relating to the weight measurements 

of the machine, such as a faulty cup.  

Gradingprogram folders 

administration  

Add/Remove/Rename template folder  

Add/Remove/Modify template programs  
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Splitting Lanes 

The TrueSort system is capable of splitting your machine into virtual machines. This option is particularly 

useful when quality grading is done manually. For example a four lane machine could be split into two 

virtual machines. Virtual machine A with lane 1,2 and 3 could do first quality produce and virtual 

machine B with only lane 4 could be set to do second quality produce. All produce is sent to lane 1, 2 and 

3 and manually, second quality produce is picked from lane 1, 2 or 3 and put on lane 4. To configure 

TrueSort for virtual machines click on the Settings button within the grading program dialog and from 

the popup menu choose Split Lanes.  

 

Configure the amount of virtual machines by specifying a name, the lanes and the sort/variety.  

Of course this option can also be used to split the machine into two lane groups to run different types of 

produce each with their own grading criteria’s and statistics.  

Below examples of the grading program and distribution. These windows have all received extra tabs for 

each virtual machine and so each virtual machine may have its own settings. The same applies for the 

statistics.  
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Measurement Results 

Two icons on the main toolbar are available to diagnose the measurements.  

Textual results 

The first icon will show measured results in table view. This option is very useful as it will show 

you all the measured results for one lane or one measure method for all lanes. If the produce is not 

classified the way you would expect, this would be the first tool to use. Below the two different views for 

the results. On the left the per lane view is chosen and all the measured results for the produce on this 

lane are displayed. Also the class is shown and this is very helpful for diagnostics. If the class shows 

'Invalid' or 'Unclassified' then something could be wrong. Please check the troubleshooting page for 

more information. On the right a measure method is selected and all the measurements (for all lanes) is 

shown. This is particularly nice to determine if the grading criteria for a measure method are set 

properly. It will - for instance - quickly give you feedback on the average percentage of blush or defects.  
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Image results 

The second icon shows camera images for one piece of produce at a time with overlays and 

measured results. Great for checking the quality of the images and the synchronization of the cameras. 

The dialog to view these results may look different than the example below. Different kind of produce 

and different kind of machinery demand a different approach on how to show the image results. 

However, the same way of checking applies to all these different views. The processed images should 

show a sharp contour exactly where you would expect it to be. The contour should not be disturbed by 

dirt or leaves. If it is, clean the area under the camera. Also the contour should not be cut-off in any way. 

Some exceptions to the rule though as the tips of long pears for instance may sometimes go past the 

image boundaries. Below an example of a good scan. Eight images were captured while the apple was 

rotating under the camera. The eight images look good as no part of the apple is cut-off. Click on one of 

the 'thumbnail' images to select it and it will be shown with processed overlays (bigger image below). 

The overlays show which part of the apple is 'seen' as blush. The contour here is well defined.  
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Backup/Restore Your Data 

 

TrueSort Maintenance enables you to backup and restore your TrueSort software and data.  

You will find TrueSort Maintenance under Start menu → All Programs → Ellips. Normally there will be a 

shortcut on your desktop as well.  

Note that you can run TrueSort Maintenance only with Administrator rights.  

Always close the TrueSort GUI before starting TrueSort Maintenance.  

After you start TrueSort Maintenance you can choose for the backup or the restore procedure. The panel 

on the right tells you in which folder the backups can be found on the Windows system. If you want to 

make a safety copy of one of the backups you can copy it from that folder to a destination of your own 

choosing.  

 

Backup Procedure 

When you choose the Backup procedure the Ellips Archiver opens. This dialog shows the location of the 

backups and a table of backups that were made previously.  
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To create a backup: 

1. Check the 'Software' box if you want to backup the software (recommended). This will create a 

backup of the 'D:\Program Files\Ellips' folder. 

2. Check the 'Data' box if you want to backup data (recommended). This will create a backup of the 

'D:\udata' folder. 

3. Press the Backup button to start the procedure. 

The lower part of the dialog shows the progress. After the procedure has finished you will see a new 

backup entry in the table. 

You can abort the backup procedure by pressing the Cancel button. The results of the current procedure 

will be lost then and no backup is made.  

Exit 

Press Exit to return to the TrueSort Maintenance Main Panel.  

Restore Procedure 

When you choose the Restore procedure the Ellips Archiver opens. This dialog shows the location of the 

backups and a table of all available backups.  

This table shows:  
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• The software version of the backup. 

• The date when the backup was made. 

• The filename that contains the backup (this file can be found in the location shown on top of the 

dialog). 

• Whether the backup contains software and/or data. 
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To restore a backup: 

1. Select the backup you want to restore from the table. 

2. Check the 'Backup before restore' box if you want to create a backup of your current software or 

data (recommended). This will create a backup of the current software and/or data before it is 

overwritten with the restored version. 

3. Check the 'Software' box if you want to restore software (this is possible only if the backup 

contains software). This will overwrite the current contents of the 'D:\Program Files\Ellips' 

folder. 

4. Check the 'Data' box if you want to restore data (this is possible only if the backup contains 

data). This will overwrite the current contents of the 'D:\udata' folder. 

5. Press the Restore button to start the procedure. 

The lower part of the dialog shows the progress. After the procedure has finished you will see a new 

backup in the table. 

You can abort the restore procedure by pressing the Cancel button. Your current TrueSort software and 

data will remain then.  

Exit 

Press Exit to return to the TrueSort Maintenance Main Panel. 
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System Maintenance 

The TrueSort system requires very little maintenance. Especially when a number of precautions have 

been taken.  

Computers 

The computers should be stored in a well-ventilated, dust free environment. Also vibration should be 

kept to a minimum. Special care must be taken for the Windows computer as it has a hard disk which is 

more vulnerable to shock/vibration. The power line must be protected by a double conversion/online 

UPS. Please read the wiki for more information:  

http://en.wikipedia.org/wiki/Uninterruptible_power_supply  

The master/slave computers have a replaceable filter. Please check these filters from time to time and 

make sure they are clean. Please contact your dealer if you do not know where to find the master/slave 

computers. To access the filters open the front lid (19” rack) and pull the plastic lever.  

                

Cameras 

The cameras need very little maintenance to no maintenance at all. Check the glass part of the lens once 

in a while to see if dust has been collected. We have seen spiderwebs on the lenses occasionally. 

Spiderwebs or dust may be removed with a microfiber lens cleaning cloth.  

Be careful not to adjust the rings on the lens! These adjust the focus and iris, so changing them will make 

the images blurry or too dark/light, resulting in bad images and incorrect grading results.  

Camera Lights 

Check the camera lighting on a regular basis.  

• Sometimes vibration causes lamps to stop working.  

• Some machines have covers over the lamps and these covers may need to be cleaned.  
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• Halogen lights are the most popular in our current setups. On average the lifetime of the halogen 

lamp is about 2000 hours.  

• Replace the lamps in time as it is difficult to see the decrease in light but it rapidly influences the 

quality of grading. 

Weight Sensors 

Weight sensors are very sensitive to collected dirt. To measure the produce within the accuracy of a 

gram the weight sensor must be able to move freely. Make sure the weight sensor bridge and all its parts 

are clean and if specified by your dealer well lubricated.  

 

Troubleshooting 

Please check the most common problems below to see if it fixes yours. If not, please ask customer 

support for assistance.  

• System will not start 

• System status is: Red cross 

• System status is: Yellow exclamation mark 

• Status says 'Master not present' 

• Weight measurement is bad 

• Too many produce goes to the end of the machine 

• Many mistakes in classified exits 

System will not start 

If none of the computers have started the UPS is probably still switched off. Switch on the UPS to get the 

system started. If the UPS is on and only one computer is not starting, remove its power, wait for a 

moment and reconnect to see if it will start. If the Windows computer starts but locks up or reboots, you 

might need to contact customer support to help you restore the Windows operating system.  

System status is: Red cross 

Something is wrong with the system and it is probably grading in a bad way or not at all. Click on the red 

sign to get more information. If you see a “master not present error” check the special item on this topic 

further down this page. If not, you might have some hardware failure. Remove the mains power from 

the master, wait for a few seconds and reconnect it to see if it solves the problem. Be patient as it may 

take a few minutes for the master to connect to the Windows computer.  

System status is: Yellow exclamation mark 

The yellow sign is a warning. If you are switching to another grading program, it is normal behavior, the 

system is warning you that the grading program switch is postponed until the last classified produce at 

the time of switching has been dropped at the exit. Click on the yellow sign to get more information.  
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Status says 'Master not present' 

This status message means there is no communication possible between the Windows and the master 

(19” rack) computer. There could be a number of reasons:  

• During startup (or intentional reboot of the master) this is a normal message, be patient for a 

few minutes, the message will disappear automatically. 

• Master is off → Switch it on!  

• Master is rebooting continuously. On the Windows computer you will continuously see pop-up 

messages that the network cable to the master is plugged/unplugged. 

1. Bad Ethernet cable/connection. Check the cable between the Windows and master 

computer. 

2. The master computer has lost its BIOS settings. Maybe the battery on the motherboard is 

flat or the settings have been reset due to some other reason. You will need to connect a 

monitor and keyboard to the master computer. Check the battery voltage. If it is less than 

3.0V, replace the battery. Now restore the BIOS settings. The main setting is that it must 

boot from the onboard network card. Please contact support in case you need assistance. 

3. Someone has made modifications to the network settings. Log in as administrator and check 

to see the if the network settings have changed. The 'To Master' LAN connection must have 

a static IP address: 192.168.99.1 

4. Someone has made modifications to the firewall settings. Log in as administrator and check 

to see the if the firewall settings have changed. Some Windows PC's are equipped with a 

firewall or a virus scanner for connection to LAN. These mechanisms can cause delays in the 

network connection from Windows computer to the master and cause startup errors. 

Sometimes the master has to boot more than 10 times to get a proper connection. Advice is 

to switch off the virus scanner and firewall controlling the Windows-to-master connection as 

this connection is local/private and completely safe. 

These firewall protection measures must stay on for the company LAN connection.  

• Master is crashing or locks up. This could be a hard- or software problem. If you are capable, you 

might want to try to clean the contacts of the interface cards. If nothing helps, contact support 

for assistance. 

Weight measurement is bad 

If your weight measurement is bad, stop the infeed and wait for all produce to drop from the machine. 

When all the cups are empty leave the machine running and click on the Tare Cups icon from the main 

toolbar. Wait for a few turns of the machine and see if all cups are more or less zero gram. If so, you can 

start grading again. However, if some cups are not more or less zero gram, locate the cups and check if 

they are sticky or dirty and clean or replace them if necessary. If a cup has a low weight like -50 grams or 

less, it is possible that a product was in the cup at the time of initialization of the empty cups weights. 

Reset the empty cup weights once more to see if it fixes the problem.  
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Too many produce goes to the end of the machine 

There are several possibilities that can make products go to the end of the machine:  

1. Product characteristics (weight, diameter, color etc.) do not match any of the classes in the 

grading program. 

2. One of the measurement units has not been able to do its measurement for the product. The 

product is then classified as invalid. 

3. Product shape/size or mechanical imperfection has made the product jump to another position 

on the machine. The electronic system cannot locate the new position of the product and it will 

go to the end of the machine. 

4. The product is sticky or small resulting in a problem to drop it on the exit. 

5. A solenoid (electronic device which makes the cup drop) has a defect which makes it impossible 

to drop the product on the exit. 

6. The software configured distance for a drop-out is wrong or has changed possibly because of 

chain stretch. 

Solution:  

1. Open the Measurement Table dialog (from the main toolbar choose Results). Click on the 

Advanced button and check the option Invalid/Unclassified. Now the table will only show invalid 

or unclassified results. Check the results of each measure unit on one of the lanes and see why it 

does not match any of the classes in the grading program. 

2. Open the Measurement Table dialog (from the main toolbar choose Results). Click on the 

Advanced button and check the option Invalid/Unclassified. Now the table will only show invalid 

or unclassified results. Check the results of each measure unit on one of the lanes and see which 

measure unit is not giving a result. Open the Image Results dialog and check the images. Most 

common problem is a dirty background or a bad setting for the background separation. If the 

machine/cups/rollers are dirty (under the camera) → clean the machine. If it is the background 

separation, check the Background Separation settings. 

3. Put as many products of different shapes and sizes in an easy pattern (for instance, leave one 

cup empty between every product) at the infeed of the machine. Run the machine with an 

empty grading program (no exits defined to classes) and see if the pattern stays intact. If not, 

one or more product changed their location on the machine. Contact your machine 

manufacturer to see if he can solve the problem for you. 

4. Contact your machine manufacturer to see if the cups can be adjusted to drop with a higher 

speed. 

5. Check the power of all the output boards (Profi-PWM24 or Profi-Output). Make sure that not 

only the board has power but also the solenoids. If your machine works with air pressure, make 

sure the air pressure is OK. 

6. In this case products of a specific class are going to the end. Check the solenoids/drop-outs at 

the exit(s) of this class. 

7. Check/adjust/fix the chain first. Then adjust the exit distance in the 'System Configuration' dialog 

'Drop-Out' tab. 
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Getting Support 

There could be a number of reasons why you would like support. Maybe you would like to classify the 

produce in a particular way but you cannot find how to do it. Or something is wrong because the classes 

are mixed and you do not know why (maybe the system status shows a red cross?). For the latter please 

read the Troubleshooting section first.  

To get help please call your local dealer first. If it is not an trivial problem you will probably be asked to 

connect the system to the internet. A good fast internet connection is mandatory. It is your responsibility 

to make sure it is available and working properly. Without it we might not be able to help you and you 

will be billed for the time we have to spend, which is usually considerably more if the internet 

connection is not working properly (or not at all).  

Now, before we can actually access your system you will need to setup the connection to our support 

computer. Minimize the TrueSort application. If you do not know how, look for the three small icons 

above the Ellips logo in the top right of your screen. Now click on the left one (looks like a minus sign). 

The application is now minimized and you should see your desktop. Your dealer may have added an icon 

to connect to their support computer. If not, look for the 'Ellips Fast Connection' or 'Ellips Support VPN' 

icon and double click it. Now press the connect button and you will be connected. Do not change the 

login credentials as they have been preconfigured and stored for your convenience. Once the connection 

is established call your dealer or Ellips to let them know you would like support and are connected (we 

are not actively checking if someone is connected to our support computers).  

To communicate with our support colleagues use the chat box  

(click on the chat box icon on the main toolbar).  

 


